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Introduction

Welcome to GEOS Companion, 1990

DON’'T BE FOOLED BY THE TITLE. This disk, which might well
have been called GEOS Power Pak III, but instead has been named
GEOS Companion, is in keeping with RUN’s tradition of offering
quality accessory disks for GEOS users. Like the Power Paks I and
I1 before it, GEOS Companion is packed with applications, utilities,
fonts and clip art. It offers C-64 and C-128 GEOS owners the tools
needed to enhance the GEOS computing experience.

Featuring the talents of some of the best programmers in the
GEOS community, GEOS Companion includes programs that will

run under either GEOS 64 or GEOS 128.

THEMES

Since one of the themes of this disk is creativity, we’ve included
programs designed for the skilled as well as the non-artist. This disk
will satisfy both the graphically gifted and the musically blessed. The
GEOS Companion programs, including fonts and clip art images,
are designed for artists to show off their talents and also to bring
out the latent sensibilities of those of us who may not be as artistically
inclined.

With its emphasis on productivity, GEOS Companion also includes
some powerful utilities to assist you in using GEOS effectively.

And, to dispel the notion that GEOS owners don’t like to have
fun, we also include a couple of games.

LINEUP

G.0.Bach, an electronic music synthesizer, will have you cranking
out tunes—whether your tastes run from jazz to classic to rock to
the weird and off-beat. With this musicmaker, you can create your
own songs (from Mozart to Mancini to Madonna) and generate
interesting sound eflects.

Just when you thought you'd seen everything for GEOS, along
comes geoAnimator, featuring the GEOS programming talents of
Francis Kostella. This innovative program (perhaps the centerpiece of
this disk) lets you create your own animations that run under GEOS.
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Entertaining, challenging, and most of all fun. That's how we
describe the game programs we've included on this disk. Decode!
1s a colortul, musical version of the classic MasterMind that’ll keep
you guessing the color sequences for hours (or less, if you've sharp-
ened your deductive abilities).

For more arcade action, try 3-D geoBreak. Sure, you've played
the classic Breakout arcade game, but you’ve never been challenged
like this.

Noted GEOS talent Susan Lamb has produced fonts and clip art
that you can use to create distinctive and visually pleasing documents
and artwork. No need to design your own fonts when you can choose
from this selection of over a half-dozen original and never-before-
published fonts. They’re suitable for letters, headlines, memos, News-
letters, signs or any other use you can imagine.

Over three dozen clip art images also grace this disk. The images
depict a holiday and special-occasion theme and add just the right
touch to cards, letters or calendars.

When it comes to useful utilities, this disk has it all. Pattern Editor
2.0 1s the latest version you’ll need to create custom fill patterns for
use within geoPaint. You can edit any of the 32 GEOS system patterns
and save them to disk.

GeoMusic Player lets you play the music files you created with
G.O.Bach.

GeoWrite File Merger adds a merge function within geoWrite
and lets you combine two geoWrite files into one.

1581 Boot-Disk Maker, as the name implies, creates a bootable
GEOS disk for 1581 users. It’s a handy tool for formatting the new
1581 disk and copying the old boot disk to it.

With Batch Copier you can select files to copy from one disk drive
to another. Like all of the programs on this disk, it runs under either

GEOS 64 or GEOS 128. It’s especially handy if you have many files
to copy at once.

And, finally, with AutoLoader you can automatically load and run
a specified file, and it can be used with any GEOS program.

S0, there you have it. As handy as the pocket on your shirt. Easier
to use than automatic drive. Offering more variety than a Whitman’s
sampler. And as difficult to resist as holiday feasting. We’re sure
you'll find GEOS Companion just what the computer doctor ordered
to help you get the most out of your GEOS system.

—RUN Editors
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How lo Use Your
GEOS Companion

First of all, keep in mind that these programs, fonts and clip art
are accessories to your GEOS 64 (or GEOS 128), and cannot be used
without it. In order to access the fonts or art or to run the programs,
it 1s necessary first to load GEOS. (Note: all the programs will work
with both GEOS 64 and GEOS 128. See each “RUN it right” in the
documentation for system details.)

‘Second, make back-up copies of both sides of the Companion
disk; do not use the original disk beyond making the copies. It is
not copy-protected in any way, nor does using it require any in-
stallation procedure, but there is not enough room on the original
disk to use it in working with the programs, fonts or art. So make
your backups of both sides right away, using the Copy command in
the disk menu. (You can find instructions for copying a GEOS disk
In your GEOS manual.) Once you have made copies of both sides
of the GEOS Companion disk, put the original away for safekeeping.

Third, copy the files you need from the backup copies of the
Companion disk to your GEOS work disks. If you want to use fonts,
copy them to your geoPaint or geoWrite work disk.

1o make a copy of any file on the disk, simply click once on the
icon and move it to the bottom of the screen. Then insert the
destination disk into the drive (or a second drive) and open that
disk. Finally, move the file icon from the bottom of the screen onto
the now open disk window. The file will be duplicated on the disk.
If you possess only one drive, you may have to switch disks several

times, depending on the size of the file. You'll be prompted by GEOS
if this is necessary.
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RUN it right: C-64 or C-128 (40 or 80 columns); GEOS 64 or 128

G.0O.Bach

By Francis Kostella

G.O.BACH IS CONFIGURED to resemble an electronic music syn-
thesizer with a three-voice, 20K-note sequencer. Its operation, in-
tended to be intuitive, is divided into the three editing “screens”
that the following tutorial describes. Table 1 further summarizes the
commands and functions. (Note that in this text the keyboard keys
are designated with uppercase letters for the sake of clarity. You
should not use the shift key when typing them in, however.)

LOADING THE PROGRAM

There are two different versions of G.O.Bach on the GEOS Com-
panion disk: G.O.Bach-40 and G.O.Bach-80. They are for different
screen resolutions, the first for any version of GEOS 64 and tor
GEOS 128 in 40-Column mode, and the latter for GEOS 128 1n 80-
Column mode only. The two versions are functionally equivalent;
that is, they both perform the same editing functions and have the
same features. The one advantage of the 80-column version is that
it runs in the 128’s 2-MHz Fast mode.

GEOS 128 80-column users should note that G.O.Bach-80 does
not allow you to switch between 40- and 80-Column modes. Also,
if you have a monochrome 80-column monitor, you cannot see color
in 80 columns, and therefore might find the 40-column version
more to your liking.

In getting started, the first thing you should do is make a music
work disk. Copy the appropriate version of G.O.Bach and deskTop
to the work disk, along with any sample music files you'd like to
examine or edit. Take care that you have only one of the two versions
on the disk; otherwise, when you double-click on a music file (to
load G.O.Bach and then the music file to edit), GEOS won’t be able
to tell which version to load, and loading the wrong one might crash
your system. Moreover, never use your GEOS Companion disk as
a work disk! Even if you have an REU, make a work disk and copy
the files you need from the disk to the REU.
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When you have the work disk made, double-click on G.O.Bach,
and the program will load. You're first presented with a Dialog Box
having three options: Create a new music file, Open an existing
music file, or Quit to deskTop. Since youre creating a new file, click
on Create and enter the name of the file, perhaps “test” for simplicity.

In response, G.O.Bach creates a blank file with the name “test”
and takes you to the Grid Edit screen, which is where you enter
notes into your composition. We'll come to that in a moment, but
first you need to create the sounds that will make up the composition.
This 1s done on the Patch Edit screen. To get there, click on the
menu option marked Patches. Grid Edit and Patch Edit are two of
the three editing screens in G.O.Bach; Modulator Edit is the third.

To move to any one of the three, simply click on the menu selection
for that screen.

CREATING PATCHES

The different parts of sound generation hardware are often
thought of as modules connected or “patched” together to form a
particular sound. G.O.Bach adheres to this concept by grouping the
different parts of the computer’s SID chip in boxes on screen. The
box below the menu in the upper left contains the Waveform switches.
To the right of this are the Envelope shape controls. Directly below
1s the Pulse Width setting for the Pulse waveform. Below this are
the Filter controls, and beneath them are the Modulator controls.
The drawing of a piano keyboard is for your reference only and is
not used to change any SID settings.

I'll first discuss creating a simple patch and then go into the Patch
Edit screen in more detail. The first thing you do is turn up the
volume so that you can hear the patch. Unless you have a specific
reason for doing otherwise (like fading a song in or out), you should
always set the volume to 15, the maximum. Move your pointer down
to the Filter control box and start clicking on the box labeled “Vol.”
(or “Volume” in the 80-column version) until the number changes
to 15.

Now you need a waveform, so move the pointer to the Waveform
box and click on the Sawtooth switch, changing it to the On position.
To turn it off, just click on the switch once more. In all of G.O.Bach,
clicking on one of these switches changes it to its opposite state.

Pressing on the Z, X or C key should produce a clicking sound.
This is not interesting, so you need to shape the sound with the
Envelope controls. Move the pointer to the row of LEDs labeled
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Sustain. The LEDs should all be dark except for the first one, which
means Sustain is effectively off. Click on the next LED to the right
and press the Z, X or C key again. Hear anything? Keep playing
the keys on the keyboard (shown at the lower-left c_orner) while
selecting higher and higher LEDs (further to the right) for the
Sustain. The sound should get louder. Choose a Sustain value
around the middle; then go directly below it and click on the
corresponding LED in the Release row. Now play a few keys and
notice how the sound dies away. I'll discuss Envelopes and other
features on the Patch Edit screen later, but now let’s create a bass
sound to use on the Grid Edit screen.

The keyboard octave is selected with the number keys 1-8. Lo?k
at the piano keys drawn on the screen, which tel! you the notes you're
playing. The number above the C and V keys is the current octave.
If you want a bass sound, hit the number 3 key and play a few notes.
If you think there’s too much sustain for a bass note, choose the 5th
or 6th LED on the Sustain row. Sound better? Now let’s name this
patch in preparation for using it on the Grid Edit screen.

To the right of the menu at the very top of the screen, you see
the bold word “Patch,” and to the right of that a box with a number.
This is the patch number currently being edited. To the right of
this are two arrow icons for scrolling forward or backward through
the set of patches, and to their right is a box that shm_vs the (optional)
name of the current patch. When you click on this box, a cursor
appears. Type in the words “simple bass” (without the quotes) and
hit return. | y

Patches don’t have to be named, but when you’re working with
the Grid Edit screen, it’s much easier to select a patch by name
instead of number, especially if you're using lots of patches in a
song. In selecting a Patch name, which can be up to 16 characters
long, try to indicate what the sound is. You may find that you
remember the sound better if you devise a name that’s! bizarre rather
than purely descriptive. For example, “warbling bells” is much more
evocative than “flute #10.” < - _ |

Now you can go to the Grid Edit screen by clicking on Grid Edit
in the menu.

THE GRID EDIT SCREEN

The top row of the Grid Edit screen, to the right of the menu,
tells you which file you are editing. In the current case, it should
say “file: test.” To the right of the file title are three numbered icons,
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used for selecting which of the SID’s three voices you want to edit.
Or you can use the number keys 1, 2 or 3 for this purpose. The
icon for the current voice is highlighted in color; the other two
appear 1n black and white when inactive.

Directly below the voice icons you see a three-octave keyboard
(s1x octaves in the 80-column version). Since only part of the SID’s
range of eight octaves can be visible at one time, you use the + and
— keys to scroll the keyboard left and right. As you do so, the value
marked “Oct” (to the left of the keyboard) changes to indicate the
octave number of the lowest key, which is a C. Now try clicking the
pointer on any cell near the middle of the top row of the grid below
the keyboard. The cell lights up, indicating that you've entered a
note. Then hit the + and — keys and see how the note moves left
and right, an octave at a time. The note isn’t changing octaves; your
view of it 1s changing, for you’re merely moving a window back and
torth so as to view all eight octaves of the 96-cell-wide grid. As an
alternative to the + and — keys, you can click on the left- and right-
arrow 1cons located at the left of the grid (near the bottom of the
screen In the 40-column version and near the top in 80 columns).

As a next step, move the keyboard until the octave number is 3
and then position the pointer on the top row of the grid, right under
the leftmost key. (If you have trouble positioning the pointer, use
the cursor keys.) Now click the pointer or hit the return key, and
the cell will be highlighted in color. You've just entered the first
note of a song. To play it, press the P key. To add more notes
position the pointer in the same place and hit the cursor down ke};
and then return. Do this eight times, until you have eight colored
cells lined up vertically. Hit the P key again, and you should hear
eight notes all on the same pitch. Notice how the darker cells below
start to scroll down. When we started, there were no notes below
the ﬁ}*st row, so the grid was dark to denote the end of the current
voIce’s notes.

The note in the top row is the first played, and the note in each
subsequent row is played after the note in the row immediately
above. Cursor up and down and scroll the grid left and right to add
or change notes. Since each row can contain only one note in a
given voice, a note placed in a row already having one will erase

the first. If you want to enter a rest (a blank row), hit the space bar
instead of the return key. When a row is blank, the far-right “com-
mand” column will change to a dark green in that row to indicate
a rest. In this way, if you scroll the grid left or right beyond any
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currently entered notes, you'll know that a row already has a note
in it if the command column in that row is the same color as the
normal grid. If it is dark, then that row i1s blank, a rest.

VOICE CONTROLS

Now that you've got a rudimentary bass line, suppose you want
it to repeat 12 times, say, but you don’t want to have to enter those
same notes 11 more times. Using the voice control commands, you
can make G.O.Bach repeat any section of music up to 255 times.
Just move the pointer to the first row and press the up-arrow key,
which brings up the Voice Control Dialog Box. If you've followed
directions up to now, the switch labeled “New patch” should be 1n
the On position. Click on the switch labeled “Start Repeat” to indicate
that the note in this row will be the first of a series of notes to repeat.
Now move the pointer to the box to the right, labeled “Repeats,”
and click on that. The pointer then disappears, and is replaced by
a cursor. To have the series of notes played 12 times (which means
played once and repeated 11 times), enter 11 and press return. (If
you leave the Repeat at zero, it will never be repeated.) Now click
on the OK icon to exit. The last cell in the row will be highlighted
in a bright color to indicate that there’s a command that must be
executed before the note in this row is played.

To specify the end of the repeating section, move down to the
row following the one that contains the last note in the sequence,
and hit the up-arrow key. To emphasize this important direction:
Since commands are executed before a note is played, you must, in
order to repeat a sequence, indicate the start on the row where the
first note is, and indicate the end on the row after the one containing
the last note.

Again, this brings up the Voice Control Dialog Box. If you've
followed directions up to now, the switch labeled “Kill Voice” should
be in the on position. Click on the switch labeled “Goto Repeat
Start” to indicate that before this note is played, G.O.Bach should
go to the last Repeat Start. Then, when you click OK to exit and hit
P to play, you should hear your eight notes play 12 times. 'lo stop
the song while it’s playing, just hit the @ key.

You’ve no doubt noticed that there are a few more controls on the
Grid Edit screen. Directly below the grid are two sets of up- and
down-arrow icons. The set on the left moves the grid up and down
one row at a time (or, you can use the F5 and F7 keys to do the same
thing). The other set of arrow icons moves the grid up and down a

1990 - GEOS COMPANION b



whole screen (16 rows) at a time. (Again, there are keyboard equiv-
alents: the F1 and F3 keys.) Note that you must have at least one
entire screen of notes for this set of icons to function. Picturing the
visible grid as a window on a piano roll, you can use the function keys
to move up and down and the + and — keys to move left and righ)::

PATCH EDITING IN DETAIL

Go back to the Patch Edit screen, make sure you're editing patch
#1 (use the left- and right-arrow icons to change the current patch)
Eqd click the pointer on the Copy icon, thus saving a copy of your

simple bass™ patch. Now use the right-arrow icon to select patch
#2 and then click on the Paste icon to paste your saved copy into
ga:dl: #2, which you'll use as a rhythm accompaniment to your bass
atch.

You’'ll want to play this voice a few octaves higher than the bass
so hit the 5 key and play a few notes. Notice how the same patc};
takes on a different quality depending upon the octave in which it
is played. This sound isn’t bad, but you want to create something
different enough to be easily distinguished from the bass, so first
you change the waveform. |

Switch off the Sawtooth and turn on the Pulse waveform. Now
striking a few keys should produce no sound. That’s because the
Pulse waveform depends on the Pulse Width being set at a value
greater than zero. You change the Pulse Width by moving the pointer
in the Pulse Width Box (below the ADSR box). Move the pointer to
the bo'x marked “PW:” (“Pulse Width:” in the 80-column version)
and click on it, and the pointer disappears.

Now, with your left hand, play a few notes on the bottom row of
keys, and with your right hand start hitting the + key to change
the Pulse Width value. Notice how the different Pulse Width values
change the sound quality. You can use the — key to move the pointer
to a lower value. You can also use the four cursor keys to change
tl_le value in small increments. For now, choose a value of about 200
hit the return key, and the pointer will reappear. ,

Next move to the Triangle switch, turn it on and play a few notes;
notice how_ the sound is much fuller. Pulse and Triangle make ;
g;}lod combination when the Pulse Width is less than half its possible
value.

Move the pointer to the row of Attack LEDs and select the 7th or
8th LED. Then move directly below to the Decay row and choose
the same value. Hit a few keys and notice how the sound doesn’t
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immediately come on, but has a gradual buildup. Select the same
value for Release to make the note gradually die out. Attack, Decay
and Release represent time values: the smaller the value, the shorter
the duration. Sustain, on the other hand, represents a level, acting
almost like a volume control. You'll find that the Attack, Decay and
Release values that work best are generally in the middle of the
scale. To become familiar with the different values, try using each
one individually, changing the value as you play notes to see how

the envelope changes. Note that Release requires some Sustain to

function properly.
The sound you’ve just created is a cross between a reed instrument

and an organ, with perhaps a bit of horn and string quality, so you
might name this one “reedy strings,” just for the fun of it. Now make

a copy of this patch with the Copy icon and move to patch #3.

FILTERS

Looking now at a few of the other areas on the Patch Edit screen,

let’s explore the Filter Box. Use the Paste icon to copy the last patch

to patch #3, and click on the switch labeled “Filter.” Hitting a few
keys gives you nothing, because, although the Filter is on, you haven’t
yet selected a filter type. Turn on the switch marked “Low” and
play a few notes. The sound is barely audible.

“Low” indicates a Low-pass, “High” a High-pass and “Band” a
Band-pass filter type. What you’re passing are the notes below the
filter frequency. A Low-pass filter passes all the tones below the
frequency set in the “FF:” (“Filt Freq:” in 80 columns) box and
softens those tones above the frequency. Likewise, a High-pass filter
passes those tones above the frequency and softens those below. A
Band-pass passes the tones in a short band around the filter fre-
quency, softening those both above and below it. Different Filter
types can be combined, but using all three at once accomplishes

very little, except perhaps when using the modulators.
If you move the pointer to the box marked “FF:” and click, the

indicator moves in the same way and with the same keys as the
“PW” box. Play a few notes as you move the slider up and down;
eventually you'll reach a point where the notes become much “bright-
er.” Change the octave with the 1-8 number keys and notice how
different octaves are softened at different places on the filter fre-

quency scale.
Now, hit return, move the pointer to the box marked “Res.”

(“Resonance” in 80 columns) and click on it until it reaches the
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maximum value of 15. Resonance is a type of feedback that occurs
around the filter frequency. You can turn on the “Band” switch to
heighten this effect. Now reselect the “FF:” box and move the filter
frequency down until it is almost zero. Hit return to get the pointer

back and hit the 6 key. Play a few notes, and you'll hear that it
sounds very distant.

MODULATORS

You can make this sound more interesting by using G.O.Bach’s
two modulators. At the bottom right of the screen are eight switches,
the top row labeled “M1” and the bottom “M2” (“Mod 1”” and “Mod
2" on the 80-column screen), standing for Modulator 1 and Mod-
ulator 2; but what are the modulators?

G.0.Bach’s modulators are software oscillators (the SID chip’s
three voices are hardware oscillators) that you can use to modify
values of different patch settings by cyclically adjusting them. This
s the way to produce a “vibrato” effect. In its extreme form, vibrato
s the way the pitch of a siren “rises and falls,” with the tone made
to increase and decrease by modulating it with slow sine or triangle
waves. To demonstrate this, click on one of the “Freq High” switches
and play a few notes. The pitch of the note you play is being
modulated by a triangle wave. The nice thing about G.O.Bach’s
modulators is that they are totally programmable; but more on this
later.

Check the four sets of switches for each modulator. The two
switches on the left are labeled “Freq High” and are used to modulate
the pitch of the patch in a big way, as we just demonstrated. The
“Freq Low” modulators apply a slight modulation to the frequency
of the patch. The “Pulse Width” switches turn on the modulation
to the patch’s Pulse width. The “Filter Freq” switches are used to
modulate the Filter Frequency, which is what you want to do in this
case. Switch on the top (Mod 1) switch and play a few notes. The
sound “pulses.” This is the Filter Frequency being modulated by
the waveform of Modulator One. You can make the modulation
smoother by editing the modulator a bit. Select the menu item
“mods” to get to the Modulator Edit screen.

MODULATOR EDIT SCREEN

The first thing you’ll notice about the Modulator Edit screen is a
grid being drawn and a set of points being plotted on it. This is the
set of values that make up Modulator 1. When you move to this
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screen, it always starts with Modulator 1.”Y_0u can change to the
other modulator by selecting the “Mod 2” icon at the top of the
screen. As your song is being played, the modulator cycles from left
to right. The value of any particular step is available for you to add
to the parameter you want to modulate, depending on whether the
switch has been turned on in the Patch Edit screen.

The modulator values range from 0 to 63, zero being the bottom
row of the grid. Thus, the number of steps can range ﬁ:omul to 6.1,
and you adjust it with the arrow icons under the heading “steps:".
The bold icons increase or decrease the value by ten steps, and the
plain icons move the value one step at a time. You change the values
of the individual steps by clicking the mouse button on a step. Just
as on the Grid Edit screen, you can move around the grid with the
four cursor keys and set a point with the return key.

To alter the default waveform, move the pointer down to the
lowest left-most cell (use the cursor keys if you're having trouble
positioning it) and hit return. Now use the cursor-up and cursor-
right keys once each, and again hit return. Continue moving upf
and to the right, setting points until you come to the right edge o
the grid. You should end up with a diagonal line of points. This 1s
what’s known as a Ramp waveform, or a Ramp Up wave. When you
use this shape of modulator on the Filter Frequency, it causes the
latter to start low and increase to the level of your highest point,
whereupon it drops back down to zero and repeats the pattern.

Your final step in editing a modulator is to set the Scaling Value.
The Scaling Value will tell G.O.Bach how often to move to the nex;~
step in the grid. A value of 0 makes the steps change every 60th o
a second, a value of 1 every 30th, and a value of 2 every 15_th.
Change the Scaling Value, which can range from 0 to 2553,, by using
the icons below the heading “scaling:”. Thus the “fastest practical
modulator would be two steps wide, with a Scaling Value ot 0, and
the “slowest” would be 64 steps wide with a Scaling Value of 255.
For now, make sure the value is at zero and return to tPe_ Patch Edlt
Screen, making sure that both the Filter and the “Filter Freq

switches for Mod 1 are on.

MORE PATCH EDITING

Now that you know what the modulators do, you can have some
fun using them to create some wild sounds. Try clicking the Freq
High, Mod 1 switch to on to get a space-alien sound. Now add the
Freq Low, Mod 1 switch for a spookier sound. The Filter may be
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adding some distortion, so turn it off to hear the sound more clearly.
Now turn on the Pulse Width for Mod 1. Hit the 2 key, and if you've
left the Triangle switch on, go up to the Waveform Box and turn
on the switch marked “Ring.” Hit a few notes. Weird, eh? Now hit

the 8 key and play a few notes. Aha! You've just made a patch for
a 50s’ science fiction movie.

You're just beginning to have fun, but there should be a “lead”
voice for your composition, so turn off the Ring and Freq High Mod
I switches and give this patch a name, say “piercing squeak.” Now

click the right-arrow icon to go to patch #4 and have a bit of fun.
Patch 4 should be blank. Find the icon labeled “rnd” to the right

of the Paste icon. (On the 80-column version, it’s labeled “random”
and located at the top of the screen.) This icon randomly creates a
patch, so click on it and play a few notes. If you don’t like the sound,
Just keep clicking on the icon. Try different octaves; sometimes you'll
get a better sound by turning off the Ring or Sync switches.

MORE ON THE GRID EDIT SCREEN

Select the Grid Edit option again from the main menu, and you’ll
see the grid drawn with the notes from the first voice. Now you're
going to add a second voice that repeats the same way as the first,
SO to save time, copy this screen. Hit the C key to copy the visible
screen, and then hit the 2 key to edit voice 2. To copy your saved
screen to voice 2, hold down the Commodore logo key and hit the
C key again; the saved notes will be inserted in front of the top row.
Since voice 2 had a blank note (rest) when you started, this extra
note will appear after the notes just copied. Hit the P key to play
the notes, and you should hear the same ones played by both voices
1 and 2. To test it, turn the switch under voice 1 to off and hit the
P key again.

To add an accompaniment to the bass line, turn voice 1 back on,
move the pointer to the top row and hit the up-arrow key. The Voice
Control Dialog Box will come up. Go to the box beside the “New
Patch” switch marked “Change to:” and click on it once to get “reedy
string,” your second patch. Hit OK to exit and play the song.

It the accompaniment is too busy, use the space bar to clear out
all the notes and change them into rests. Move the pointer to the
first row and enter a note below the C key (on the piano keyboard)
an octave above the bass note, making sure that the “Oct” indicator
1s at 3. Now move the pointer down to the fifth row, enter the same
note and hit P to play. Much better, but you can alter the notes
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while the song plays, which is especially useful when there is a section
of notes being repeated. So hit P to play and change the notes in
voice 2 if you like.

Now, for your “lead” voice, hit the 3 key to go to voice 3, and use
the Commodore/C key combination to paste in the notes saved from
voice 1. Use the space bar to erase all the notes and place the pointer
on the second row. You want to insert eight notes into the loop, so
use the shifted insert-delete key eight times. Note how the new blank
notes are inserted at the row where the pointer 1s. That’s the reason
for adding notes at the second row, for if you'd used the first row,
the commands to start the loop and change voices would have been
moved down, with blank notes inserted before them. Move the
pointer to the top row and hit the up-arrow key to change the patch
to the third patch, called “piercing squeak.” If you want, you can
go down to the ninth row and enter another patch change, say, to
the random patch you created, so that voice 3 will play eight notes
of “piercing squeak,” then eight notes of your random patch, and
then reloop. Enter a few notes and try it.

One more thing: Suppose you want to change the tempo of the sam-
ple song you've just created. While on the Grid Edit screen, hit the T
key to bring up the Tempo Change Dialog Box. Click on the scale and
use the four cursor keys to change the tempo. The cursor-up and
-down keys move the pointer in large steps, while the cursor-right and
-left keys change it one unit at a time. When you make this change,
G.0O.Bach will change the tempo of your entire composition.

Table 1. A list of the functions not covered in the Tutorial. (Note: Key names are
uppercase only for clarity. Do not use shift key when typing them in.)

Grid Edit Screen

KEY FUNCTION

Fl move grid up one screen (16 rows)

E3 ; move grid down 1 screen

F5 move grid up one step

F7 move grid down 1 step

+ move visible grid keyboard 1
octave up

— move visible grid keyboard 1
octave down
Home go to top of grid
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Cursor keys move around the grid

Return enter a note (same as mouse press)
Space bar clear a note

Insert Insert a row before current row
Delete delete current row

C COpYy screen

Comm. logo/C  paste screen (insert at top row)

P play song

@ stop song

o play song from grid tops

While song 1s playing:

F fast forward

D double time

f § tempo change

T (up arrow) voice commands for current row (the

row the mouse pointer is on)

Patch Edit Screen '

KEY FUNCTION
1-8 choose octave
P play song
Pulse width or filter frequency changes:
+ up 100
— down 100
Crsr up up 12 or 6
crsr down down 12 or 6
crsr right up 1
crsr left down 1

Modulator Edit Screen

KEY FUNCTION

1 edit mod 1

2 edit mod 2

cursor keys move around the grid
return change the step value
P play song
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RUN 1t right: C-64 or C-128 (40 or 80 columns); GEOS 64 or 128

Decode!

By Francis Kostella

DECODE! IS A SINGLE-PLAYER GAME that tests your ability to
make logical deductions. The computer arranges a number of vari-
colored pieces vertically in a random sequential order. These are
concealed under question marks in a column at the far right of the
screen. Then 12 columns appear, each with a number of blank
circles equal to the number of pieces in the hidden pattern.

You have 12 chances to guess the vertical sequence of the colored
pieces. Starting with the left-most column, use the input device to
click on the circles and cycle through the colors until you have the
pattern you want in a given column. After each of your selections,
you click on the “enter move” icon, and the computer tells you, via
little solid or dotted symbols below the column, how many are correct
as to color and position (solid symbol), and how many are the right
color but in the wrong row (dotted symbol). By a process of judicious
elimination, you try to arrive at the correct sequence. When you
are completely successtul, the computer confirms it by uncovering
the hidden pieces. If you don’t guess the complete pattern in 12
attempts, the correct answer is revealed.

At the beginning of the game, you choose the number of pieces
you'd like in the pattern, which is the same, of course, as the number
of rows on the board. You may select from 3 to 6, 3 obviously being
easiest and 6 the most difhicult. To change the number, simply click
on the up/down-arrow icon until you reach the one you want.

Decode! works in 40 or 80 columns, automatically configured
when loaded. After finishing a game, you can play again by selecting
“new’ from the game menu.

STRATEGY TIPS

Although random guessing occasionally succeeds, you're better off
using turns to test for various pieces. I find that the best beginning
moves involve only one or two different colors each time, until it’s
clear which ones are definitely not in the pattern. At that point, you've
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usually narrowed down the possibilities and can begin to make com-
plete guesses. It’s also useful to leave some rows blank when testing
for one of two possibilities. If you're stuck, sometimes guessing as to
a single piece clarifies things; if it doesn’t, then you need to go back
to the beginning and work through logical deduction.

RUN it right: C-64 or C-128 (40 column); GEOS 64 or 128

geoMusic Player

By Wayne Dempsey

GEOMUSIC PLAYER IS DESIGNED to play music files that were

created with the G.O.Bach music editor. To use geoMusic Player,

choose a music file from the dialog box that appears in the center

of the screen. The following four icons are displayed when the file

1s loaded:

Play —plays the music file from the beginning.

Pause—pauses the music and stops the Fast Forward function. To

continue playing, click on the Pause icon again.

Stop—stops the music and returns to the main dialog box.

Fast Forward —when the music is playing, a click on this icon speeds

you through the music file. Click on Pause to stop this function.
To return to the deskTop, click on the Cancel 1con in the main

dialog box.
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RUN it right: C-64 or C-128 (40 column); GEOS 64 or 128

geoWrite File Merger

By Wayne Dempsey

GEOWRITE DOES HAVE ADVANTAGES; however, there are many

shortcomings in the program’s design. For instance, the last thing
I want to do is sit at my computer and wait for a large geoWrite
file to finish printing. Working with geoProgrammer, I discovered
the value of a Merge function within geoWrite, and geoWrite File
Merger 1s the result.

GeoWrite Merger takes two standard geoWrite files (any version)
and combines them into one file. To use the program, double-click
its icon on the deskTop and choose “merge” from the File menu.
The program, which supports two drives and lets you switch disks,
asks you to input the source and object files. The two files are
combined in this way: Source =Source + Object. The source file
becomes the merged file, with the source information preceding
that of the object.

Some constraints are that while the source file can contain pictures,
the object file cannot, and both files must be of the same version of
geoWrite. In the later versions of geoWrite (2.0 and 2.1), headers
and footers, along with other format parameters, remain with the
source file, and the object file information adapts to fit the source
hle’s parameters.

I suggest that you make a backup of the source file before you
start to merge, because the disk drive may generate an error that
will cause the merge to terminate.
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RUN it right: C-64 or C-128 (40 column); GEOS 64 or 128

Pattern Editor 2.0

By Wayne Dempsey

PATTERN EDITOR VERSION 2.0 is a GEOS utility that, when
running under GEOS 64 or 128, lets you edit any of the 32 GEOS
system patterns and save them to disk. The new patterns can then
be installed in any GEOS application.

To use Pattern Editor, boot up GEOS and open the disk with the
Pattern Editor on it. Load the Pattern Editor by double-clicking 1ts
icon on the deskTop.

EDITING PATTERNS

When the Pattern Editor is loaded, its screen appears with the
Edit Box on the left and the Display Box on the right. Along the
bottom of the screen, you’ll see rows of boxes displaying all 32 sys-
tem patterns.

Move the pointer to one of these boxes and press the mouse
button to choose a pattern. The current pattern is shown in the
Display Box, and an eight-by-eight-bit image of it 1s illustrated in
the Edit Box.

Next, place the pointer on one of the small boxes in the Edit Box
and press the mouse button to change the pattern. As you work,
your changes will appear in the Display Box. To restore the pattern
that was current after the last load or boot, click on the Undo 1con.

I recommend that you not alter the first three system patterns,
because changes to them might cause undesirable results during
normal program operation.

FILE OPERATIONS

Use the Save option from the File menu to save your edited
patterns as a desk-accessory file named “Patterns.” In a two-drive
system, this file goes to the current drive, so you can’t swap disks.

Because the Patterns file 1s independent of Pattern Editor, it can
be copied to other disks for use in various applications. For example,
to use it with geoPaint, copy the file onto your geoPaint work disk,

16 GEOS COMPANION - 1990

and then choose the Patterns file from the GEOS menu within
geoPaint. The patterns are installed automatically, replacing the old
ones in all of geoPaint’s operations.

When you choose the Load option in Pattern Editor’s File menu,
the program automatically loads the Patterns file and erases the
patterns currently in memory. Nothing happens if no Patterns file
exists on the current disk. Once again, on a two-drive system, the
program searches for the Patterns file on the current drive.

The Quit option in the File menu returns you to the deskTop and
leaves the current patterns in memory.

VERSION 2.0

Functionally, version 2.0 is the same as version 1.0 (available on
RUN’s GEOS Power Pak I). There are changes made in the Patterns
file, and the Patterns file from version 1.0 won’t work with GEOS
128. To convert a Patterns file from V1.0, load the Pattern Editor

under GEOS 64 and load the Patterns V1.0 file. Then click on Save
from the menu to save the patterns in a new V2.0 file.

RUN 1t right: C-64 or C-128 (40 column); GEOS 2.0

3-D geoBreak

By Wayne Dempsey

HERE'S A NEW VERSION of the geoBreak arcade game. In 3-D
geoBreak, the object 1s to knock out as many blocks as you can,
using your paddle and five balls. A ball moves around a three-
dimensional board that resembles a racquetball court viewed from
the rear. Your circular paddle hovers about the center of the screen
and 1s controlled by a mouse or joystick.

To get started, click the button on your input device. The ball
appears, and all you have to do 1s continue deflecting it with your
paddle. Sounds easy, right? Wrong! The ball follows the natural laws
of motion and gravity as it bounces around. When it hits the paddle,
the ball's speed and direction change. Gameplay is an interesting
and often challenging study of the kinetics of a bouncing ball.
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You receive 100 points for each block knocked out. It’s possible
to knock out as many as five blocks at a time. Every time you gain
5000 points, you get a free ball. The number of balls you have 1s
displayed at the top left of the screen. Your score and high score
also appear at the top of the screen. High scores are retained only
during game play.

Pressing any key brings up a menu that lets you quit, continue
or restart the game.

RUN it right: C-64 or C-128 (40 column); GEOS 64 or 128
1581 and a 1571 or 1541

1581 Boot-Disk Maker

By Jim Collette

THE GEOS 64/128 1581 Boot-Disk Maker 1s made up of two separate
programs: GEOS64—1581 and GEOS128—1581. The first 1s for
GEOS 64 2.0 and the latter for either version of GEOS 128. Both
programs operate in exactly the same manner.

WHAT IT DOES

The program creates bootable 1581-format GEOS disks. It writes
its own custom GEOS and GEOS Boot files, and it also copies the
GEOS Kernal file from your existing boot disk, modifying it shightly
to support the 1581 on bootup. Since it copies the Kernal from your
boot disk, the program retains the same serial number, so all your
applications are compatible. Once the boot disk has been made, you

must then copy the deskTop, Configure, Printer/Input Drivers and
other files to the 1581 boot disk.

INSTRUCTIONS

Simply double-click the icon for the appropriate program (GEOS
64 or 128) from the deskTop. Then a short title screen explains
what Boot-Disk Maker does. Click on OK to start the process, and
you’ll find yourself guided through the entire procedure—format-
ting the new 1581 disk and then copying the old boot disk to it.
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This program accepts any disk drive configuration, as long as you
have at least one drive configured as a 1541 or 1571 and one as a
1581. It doesn’t matter which slot (A, B or C) each drive is in; if the
drives are there, the program will recognize them. If you don’t have
both a 1541 or 1571 and a 1581 active when you run the program,
you're asked to reconfigure. Execute the Configure file on your boot
disk and make sure you have both drives selected.

When the program has finished its job, you're told to copy certain
files from the old boot disk to the new one. Do this after you've
returned to the deskTop. I also recommend that, to be safe, you
write-protect the disk once you've made the 1581 boot disk and
customized it to fit your needs. Enjoy!

RUN it right: C-64 or C-128 (40 or 80 columns); GEOS 64 or 128;
two disk drives

Batch Copier

By Jim Collette

BATCH COPIER IS A HANDY UTILITY for copying files with
either GEOS 64 or with GEOS 128 in 40- or 80-Column mode. It
provides a built-in editor for creating lists of files to be copied. Then,
when you select either the Copy icon from Batch Copier or double-
click the list file’s icon from the deskTop, the selected files are copied
automatically from one disk drive to the other.

To access Batch Copier, double-click its icon from the desk’Top.

The main screen offers three options: Create a file list, Copy some
files, and Quit to the deskTop.

MAKING A FILE LIST

To start, select Create, and a dialog box appears, prompting you
to specify the disk that holds the files to be copied. Use the Drive
icon to change disk drives, or Disk to change disks in the current
drive. Once you have the right disk, select OK, and a list of the files
on that disk fills the Source box on the screen.

There are four icons at the bottom of the Source and Destination
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boxes. The single arrows, pointing up and down, scroll the list one
filename at a time. The double-headed arrows (at the far corners of
the box) move to either the beginning (up arrow) or end (down
arrow) of the list. To select a file, click on it, and the filename will
switch to reverse video. Now move the file to the Destination box
by clicking on the long arrow (in the center of the screen) that points
to the Destination box (to the right). This will append the name of
the file you specified to the Destination list. Repeat this procedure
until the names of all the files you want copied are in the Destination
list. To delete a file from the list, select it, then click on the long
center arrow that points to the Source box (to the left).

Because files are copied in the order they're listed in the Desti-
nation box, you may want to rearrange the list. To move a filename
within the list, select it, then click the Move icon in the middle of
the screen. When a window prompting you to select a new location
appears under the Move icon, pick the spot just beyond where you
want the filename to go. Then click the mouse to make the move.
Note that the Move icon is inactive in the Source list.

When you've finished creating your list, save it by selecting the
Save File option in the File menu, picking a disk and typing a name
for the file. If a file by that name already exists, you'll be asked if
you want to replace it. Indicate yes and your list will be saved.

To load a new list to work on, choose the Load File option in the
File menu, and, when a dialog box listing the files on the current
disk appears, click on the appropriate file. Then click the Open icon
to erase the old Destination list and load the new one in its place.

When you're all done with your list, select either Close or Quit
at the File menu. Close redisplays the opening screen, while Quit
goes straight to the deskTop.

To load a desk accessory from Batch Copier’s disk, select the GEOS
menu and a list of all desk accessories will appear, along with the Batch
Copier Info option. To run a desk accessory, just select its name.

Batch Copier offers a few other options under the Options menu.
Replace? displays a dialog box asking if files should be replaced during
copying. If you indicate yes, then files with the same name on the
Destination disk as on the Source disk will be replaced. If no, those
hiles will be skipped. Copy All moves all the files from the Source list
to the Destination list, and Erase All clears out the Destination list.

COPYING FILES
lo copy files with Batch Copier, you can either (1) double-click
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the list file’s icon from the deskTop or (2) select the Copy option
from Batch Copier’s opening screen. If you choose the first, the files
will be copied automatically from the disk containing the lhst file
(sometimes called the command file) to the other dlSk: For example,
if your list file were on drive B, the files would be copied from drive
B to drive A. (It doesn’t matter which disk Batch Copier 1s on; or}ly
the list file location matters.) When the copying 1s done, you're
returned to the deskTop. | o

[f Batch Copier can’t find a file that’s in the list or 1if the Destination
disk doesn’t have enough room for a given file, such files are skipped,
and execution proceeds to the next file; it doesn’t abort. For instance,
if the Destination disk has only 5K left and your list contains files
of 10K and then 2K, the 10K file will be skipped, but the 2K file
will be copied. Bin _

If you decide to use the Copy option from within Batch Copier,
a list of the files on the current disk will appear in a dialog box.
Pick the file you want (you may change disks if you wish) and select
Open. The files will be copied, again from the disk with the list file.

AUTOCOPYING

Batch Copier has one other handy feature. Ifit's run while booting
GEOS (for this job, use the AutoLoader program, also on this disk),
it will search the disk it’s on for a list file called “Auto Copy.” If 1t
finds Auto Copy, it will automatically copy the files in that list to the
other disk. Create the Auto Copy file like any other list file; just call
it Auto Copy. |

This feature is especially useful for copying the deskTop to a RAM
disk while booting GEOS. Just create the Auto Copy file and put
only the deskTop in it. You'll add only a few seconds to the boot
time if you're using a RAM disk, because all this 1s done before the
deskTop is loaded. Once the deskTop 1s copied to the RAM disk, 1t
will load from there, so it’s only loaded oft the floppy disk once—
when it’s copied. | | |

Batch Copier is a handy program to have, especially if you're a
programmer who needs to copy many source-code files at once.
Now all you have to do 1s double-click one file!
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RUN 1t night: C-64 or C-128 (40 or 80 columns); GEOS 64 or 128

AutoLoader

By Jim Collette

AUTOLOADER IS A SHORT Auto-Execute file that you can place
on your GEOS boot disk to load and run a specified file without
having to change its filetype with a disk editor. It can be run either
automatically while booting or from the deskTop.

I wrote AutoLoader to run my Batch Copier program automat-
ically while booting, but it can be used with any GEOS program.
Just bear in mind that the default input and printer drivers aren’t
selected until deskTop runs, so if it’s run during boot, no printer
driver will be selected, and you’ll need a joystick for user input.
This effectively rules out geoWrite and geoPaint, since they both
need an input device.

Also, any program to be loaded mustn’t disturb the area from
$5000 to $5FFF. This area holds the code that boots GEOS, and if
it’s trashed, the computer will crash.

In determining the file to be copied, AutoLoader uses the unique
method of checking the text in its Info sector. In that way, it doesn’t
require any input while running, so it can run all by itself.

To specity the file to be copied, select the AutoLoader file at the
deskTop. Then select Info from the File menu to display the Info
sector. On the first line of the Info sector text area, in the first
character position, type the name of the file exactly as it appears on
the deskTop. Then, right at the end of the filename, press return.
The filename must be right at the start of the Info sector text area,
all by itself on the first line. Beginning on the second line, you can
type whatever you want in the rest of the space.

It you misspelled the filename, included leading spaces or didn’t

press return, or 1if the file isn’t on the disk, AutoLoader will simply
return to the deskTop, with no harm done.

Note that you must place AutoLoader after Configure on the
GEOS boot disk.
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RUN it right: C-64 or C-128 (40 or 80 columns); GEOS 64 or 128

geoAnimator

By Francis Kostella

GEOANIMATOR ALLOWS YOU to create stand-alone animations
that will run under either GEOS 64 or GEOS 128. You create an
animation by first drawing individual picture cells in geoPaint and
pasting them into photo albums. Then you can use geoWrite to
create a script of graphics instructions that geoAnimator reads to
create your animation.

The script that the program uses to build an animation 1s made
up of a number of commands, some of which require from one to
four arguments to specify; for example, the starting screen position
for a line. If you're an experienced Basic programmer, you should
have little trouble understanding the syntax below. But first, a short
description of GEOS graphics 1s in order.

GEOS GRAPHICS

Although very few GEOS programs use it, the 40-column, lo-res
text screen (the one the 64 displays when first powering on) is helptul
in understanding GEOS graphics. This lo-res screen contains 25
rows and 40 columns of “cells”—1000 in all—which GEOS calls
“Cards.” Every cell, or Card, is in turn composed of 64 (8-by-8)
pixels (picture elements), each one of which is a single dot on the
screen. When working with the 40-column text screen, and also
when programming in Basic 2.0, you display information on the
screen by using a Print or Poke statement to place a single character
in a given card.

You can think of the screen in this mode as a grid of 40-by-25
cards. When you clip a photo out of geoPaint to save in a photo
album, geoPaint always cuts the photo on these card boundaries.
When using geoAnimator to place a photo on the screen, you always
align the left edge of the photos on the left edge of one of these
cards, but you can place them horizontally at any of the 200 scan
lines available. These cards are numbered 0-39, starting at the left
side of the screen. (0-79 for the 80-column version.)

1990 - GEOS COMPANION 23



The other way to picture the GEOS 40-column high-res screen is
as a grid of 320 pixels horizontally by 200 vertically (640 by 200 in
80 columns). You specify the position of a pixel by indicating its X
(f_lorizontal) and Y (vertical) coordinates. The coordinates of the
pixel in the upper-left corner of the screen are X-0 and Y-0, and
X-319, Y-199 are the coordinates of the pixel in the lower-right
corner.

Using this numbering system, you can indicate any position on
the screen you wish in using the commands described below. In
most of the commands, the first four letters of each keyword are all
that is required; the rest is ignored until the space that must separate
the keyword from its arguments, if any. Note that you can use only

one command per line in the geoWrite script file and that keywords
are always entered in lowercase.

pattern <pattern number, 0-31>—Set the fill pattern used by the
rectangle command.

Examples:
patt 0 (sets the pattern for rectangle to white)
patt 2 (sets pattern to “stipple”)

rectangle <coordinates: top, bottom, left, right>—Draw a rectangle,
filled with the last pattern set by the pattern command.

rectangle  top bottom left right
40 col. 0-199 0-199 0-319 0-319
80 col. 0-199 0-199 0-639 0-639
Examples:
rect 0,199,0,319 (fills the entire 40-column screen with current
pattern)

rect 150,160,5,75 (draws rectangle in lower-left corner)
Note: The value for the bottom position can never be less than
the value for the top position. Likewise, the value for the right side

can never be less than the value for the left position. This also applies
to Frame, below.

frame rectangle—Draw an outline box, similar to rectangle.

frame top bottom left right
40 col. 0-199 0-199 0-319 0-319
80 col. 0-199 0-199 0-639 0-639
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Examples: (a complete example for clearing the 40-column screen
and framing it)
patt O (“white” pattern)

rect 0,199,0,319 (clears 1t all)
fram 0,199,0,319 (draws a box around 1t)

line—Draw a line from Y1,X1 to Y2,X2.

line Y1 X1 ' « X2
40 col. 0-199 0-319 0-199 0-319
80 col. 0-199 0-639 0-199 0-639

Examples:
line 0,0,199,319 (draws a line from the upper-left corner
to the lower-right corner)

line 100,0,100,319 (a horizontal line at mid screen)

loop—Set the start of the loop and the number of times it’s to be

executed.
loop execute loop # times

1-32767

endloop—Decrease the counter set by Loop and return there 1f it

1S NOt Zero.
Note: This command must not appear before a loop command

has been used once.

endloop <no arguments> return to top of loop

Examples: (using the above two commands)
loop 20 (repeats the following 20 times)
patt 0 (sets i1t to white)
rect 25,33,67,78 (draws a square)
patt ] (now sets 1t to black)
rect 25,33,67,75 (draws a square at the same position)
endloop (goes to the instruction following the

last Loop command)
(The above example “flashes” a square 20 times.)

Note: Loop and Endloop commands work in pairs, with the Loop
instruction always preceeding the Endloop command. Loops cannot
be nested and cannot cross records. A loop starting in one record
will not repeat if the endloop is in another record.

pause— Wait for a mouse button to be pressed.
pause <no arguments> (waits for mouse press)
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Note: A pause will not indicate to the user that the animation is
paused; it is up to you to prompt the user for a mouse press. When
the animation is finished, geoAnimator adds a final Pause command
to stop deskTop from loading until the user is ready.

delay— Waste time.
delay (wastes about 1/30 of a second)
1-255
Examples:
delay 1 (shortest possible time)
loop 32000
delay 255

endloop (wastes a lot of time!)

album—Choose a photo album to take photos from.
album <filename of a photo album>
Examples:
album MyAlbum (makes current album the one named
MyAlbum)

Note: All five characters (album) must be used, followed by a
space, then the name of the photo album. Photo album names may
not contain spaces; e.g., “My Album” will not work. That name would
be interpreted by geoAnimator to mean the album entitled “My”.

photo—Place a photo (from the album specified by the album com-
mand) on the screen.

photo photo # X offset Y offset
In columns in pixels
40 col. 1-60 0-39 0-199
80 col. 1-60 0-79 0-199
Examples:
photo 1,0,0 (draws first photo from current album

to upper-left corner)
album MyAlbumOne  (selects an album to work with)

phot 1,5,20 (draws first photo from album:
MyAlbumOne)

photo 2,5,20 (draws second photo over first)

album MyAlbumTwo  (selects an album to work with)

phot 5,5,20 (draws fifth photo from album:
MyAlbumTwo)

photo 6,5,20 (draws sixth photo)
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Note: Photo numbers are the numbers used by the photo manager;
e.g., the first of 20 photos is photo 1.

link—Stop using the current script and load a new script.
link <filename of new script name>

Examples:

link NewScript (makes “Newscript” the current script)
(every command after a Link 1s 1gnored)

Note: All four characters (link) must be used, followed by a space,
and then the name of the script file. Linked script names may not
contain spaces. Also, do not link a script file to itself; use the Loop
and Endloop commands to create cycles of commands. The Link
command 1s only valid when creating an animation. During testing,
the Link command i1s ignored. Test each file separately.

comment—Tell geoAnimator to ignore everything up to the next
carriage return.

; comment follows a semicolon
Examples:

, fill the screen (reminder of following command’s
purpose) -
patt 0
rect 0,199,0,319

TESTING AN ANIMATION SCRIPT

First write a script with geoWrite and test it with the Test option
in geoAnmimator. Once you select Test from the start-up screen,
youre given the option of displaying errors (if any) on screen.
Choosing Yes shows the page and line number of each instruction,
which you then attempt to execute. If there’s an error in the for-
mation of the instruction, the type of error is printed to the screen,
and the instruction is ignored. At this point, geoAnimator pauses
and puts an OK 1con 1n the lower-left corner of the screen; just click
on it to continue to the next instruction.

Following is a list of the possible errors:
syntax error—geoAnimator has encountered a keyword it does not
understand; possibly a typing error.
range error—One or more of the arguments following the keyword
1s outside the allowable range of values.
photo exceeds border—Part of the chosen photo would be printed
off the screen. Photos printed beyond the right border will not print
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properly, and those printed below the bottom border may cause a
system crash.

no album—geoAnimator has checked drives A, B and C (if available)
and cannot find the album named in the Album command. Album
names may not contain spaces.

corrupt album or no photo—The album has been found, but the
attempt to access the specified photo is returning a disk error.
aborting . . .—The stop key will abort the testing process, and this
message will be printed.

After choosing the error-display option, you're given the choice
of having geoAnimator i1gnore any loops you've created in your
script. Choosing No results in running through every iteration of
the loop. Choosing Yes executes a loop only once, and then goes
on to the next instruction after the Endloop command.

After choosing one of these two options, you then select the script
file you want to test. The Drive icon in the file-selection box lets you
choose a file from one of as many as three drives. Note that you
must not take the geoAnimator disk out of the drive you’ve booted
it from. While you're testing a script, hit the stop key to abort and
return to the start-up screen.

CREATING AN ANIMATION

Once you've tested a script and are satisfied with the sequence,
use the Create command to create a stand-alone animation file.
Enter the name of the output file when prompted, and then your
name as the author (it will appear in the info box from deskTop).
You're then given the option of including a G.O.Bach music file up
to 5K 1n size. After choosing the script and music file, geoAnimator
will create your animation and display any errors it may encounter.
To run the completed animation, just double click on it from the
deskTop. Completed animations do not require running geo-
Animator, so you can send your amazing artwork to your friends!

HINTS

Creating a good animation 1s simplified if you understand how
geoPaint clips photo scraps from a document. In doing so, it always
clips on card boundaries, which you can locate by turning on the
color in geoPaint. You may find it useful to use a different back-
ground color behind your drawings so that you can align them
properly 1n relation to the card boundaries.

GeoAnimator, on the other hand, displays photos on horizontal
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(X) card boundaries; but the vertical (Y) position is not limited to a
card boundary, but can be any value from 0-199. If you want to
move an 1mage from the top of the screen to the bottom, you can
draw the image or series of images to the screen over and over
again and simply change the vertical position value. Moving an
image horizontally presents a challenge, for the position jumps in
8-pixel increments; so you have to move the image in geoPaint,
before you clip it out. (Use the Region move-and-copy tool with color
off.) As in any Commodore graphics, some careful planning be-
forehand pays big dividends.

Copy geoAnimator, your script file and all of your photo albums
to a work disk before starting. If you have more albums than can
fit on one drive, place those that are used in the beginning of the
script file on the work disk. GeoAnimator is fastest on CBM drives
in the following order: REU, 1581, 1571, 1541.

To get the best possible speed in creating an animation, it’s im-
portant to understand how geoAnimator uses photo albums. When
you specify a photo to use, the program first checks in memory to
see 1f 1t 1s already using that photo. If not, the current drive is
checked for the photo album named in the last Album command.
If that album isn’t found, the program then checks the next drive
in the chain, and so on. Obviously, it’s advantageous to keep all of
your albums on one drive to cut down time-consuming searches.
Also, to avoid confusion, do not have photo albums with the same
name (but different photos) on different drives.

Another important bit of information is the way that geoAnimator
stores the completed file on disk. When the program creates an
animation, it builds the file until the available RAM is full, and then
writes the rest of the information to disk. Thereupon it clears out
its work area and starts again until it has saved up to 62 records to
the animation file. Take note that you cannot change the name of
an animation created with geoAnimator; if you do, the program
tells you to rename it; otherwise, it won’t run.

Forty-column records can be up to 22.5K each, with the maximum
size of a 40-column animation 1395K. Eighty-column records can be
up to 30K each, with a maximum animation size of 1860K.

Each time a record is saved to disk, the program prints a Writing
to Disk message. Each record saved to disk can use up to ten photo
albums, containing up to 300 individual photos between them. So
you may use more than ten photo albums, but not in one record.
The largest possible photo scrap is 5K. =
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Ten GEOS Programs Included:

» geoAnimator

» G.0O.Bach

» Decode!

» geoMusic Player

» geoWrite File Merger
» Pattern Editor 2.0

» 3-D geoBreak

» 1581 Boot-Disk Maker
» Batch Copier

» AutoLoader

Plus seven fonts and over three dozen
clip art images!

It any manufacturing defect becomes apparent, the defective disk will be replaced free of charge if returned by
prepaid mail within 30 days of purchase. Send it, with a letter specifying the defect, to:

GEOS Companion e 80 Eim Street ® Peterborough, NH 03458

Replacements will not be made if the disk has been altered, repaired or misused through negligence, or if it
shows signs of excessive wear or is damaged by equipment.

The entire contents are copyrighted 1990 by IDG Communications/Peterborough. Unauthorized duplication is a
violation of applicable laws.
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